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III. Start New Drawing (from scratch) 
 
DRAWING ENVIRONMENT 
 
Before you can use AutoCAD effectively, you must understand what you seen on the screen.  When 
working in an AutoCAD drawing, the screen will look similar to this: 
 

 
 

Pull-Down Menu 
 
Contains the default AutoCAD menus. Menus are defined by menu files that you can modify or design on 
your own. See chapter 4, "Custom Menus," in the AutoCAD Customization Guide. Additionally, installing 
third-party applications may add menus or menu commands. The default menu file is acad.mnu. 
 

Toolbars 
 
Provide access to common commands. The toolbars are displayed when you start AutoCAD. These 
toolbars are docked in various locations within the window. You can easily move toolbars and turn them on 
and off. 
 
You can change the size of toolbar buttons and reposition, add, or delete toolbar buttons. You can also 
change the toolbar name and turn tooltips on and off. 
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 To modify a toolbar 
 
 1 From the View menu, choose Toolbars. 
 2 If the toolbar you want to modify is not displayed, select it in the Toolbars dialog box.  
 3 Choose Customize.  
 4 While the Customize Toolbars dialog box is displayed, you can modify any displayed 
toolbar as follows: 
 
Drag toolbar buttons right or left to reposition them. 
Create spaces by dragging a button to the right or left edge of the button beside it, but not past the middle. 
Remove toolbar buttons by dragging them off the toolbar. 
Add buttons to toolbars by dragging them from the Customize Toolbars dialog box to the toolbar. Change 
the Categories selection to display the buttons you want to add. 
Drag buttons from one toolbar to another, or press CTRL while you drag to copy the toolbar button to 
another toolbar. 
 
5 Choose Close to exit the dialog boxes. 
 
 Command line TOOLBAR 
 Shortcut menu Right-click a toolbar and choose Customize. 
 

 To rename a toolbar 
 
 1 From the View menu, choose Toolbars. 
 2 In the Toolbars dialog box, select the toolbar name, and then choose Properties. 
 3 In the Toolbar Properties dialog box, enter a new name. 
4 To change the text displayed on the status line, enter new text at Help, and then choose Apply. 
 5 In the Toolbars dialog box, choose Close. 
 

Drawing Area 
 
Displays drawings. The drawing area size varies, depending on the size of the AutoCAD window and on 
the number of other elements (such as toolbars and dialog boxes) that are displayed. 
 

Crosshairs 
 
Identifies pick and drawing points within the drawing area. Use the crosshairs, which are controlled by 
your pointing device, to locate points and select and draw objects.  
 

User Coordinate System (UCS) Icon 
 
Shows the orientation of the drawing. AutoCAD drawings are superimposed on an invisible grid, or 
coordinate system. Coordinate systems are based on X, Y, and (for 3D) Z coordinates. AutoCAD has a 
fixed world coordinate system (WCS) and a movable user coordinate system (UCS). To help you visualize 
the UCS location and orientation, a UCS icon is displayed in the lower-left corner of the drawing area. 
 

Command Line 
 
Displays prompts and messages. In AutoCAD, you start commands in one of three ways:  
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- Choose an item from a menu or a shortcut menu. 
 - Click a button on a toolbar. 
 - Enter the command on the command line. 
 
However, even if you choose commands from menus and toolbars, AutoCAD may display command 
prompts and the command history in a command window.  You can display the command history dialog 
box by pressing the “F2” button on your keyboard.  This can be especially helpful if you list an object and 
the information scrolls too far to be seen in the command line area.  Text from this screen can also be cut 
and pasted into other documents. 
 
Remember to watch the command line while working in a drawing.  Many new users become confused 
when commands do not work as they anticipated.  The command line provides you with a great deal of 
information regarding the status of your commands.  It will instruct you to select items for editing, and 
query you for information (many commands do not have a dialog box for user input).  If you do not see 
“Command:” on the bottom line of the command line area, then your last command is still active.  
Typically, pressing “Enter” will terminate the active command. 
 

Status Bar 
 
Displays the cursor coordinates in the lower-left corner. The status bar also contains buttons that you can 
use to turn on common drawing aids. These include Snap (Snap mode), Grid (drawing grid), Ortho (Ortho 
mode), Polar (polar tracking), Osnap (object snaps), Otrack (object snap tracking), Lwt (lineweight 
display), and Model (model and paper space toggle).  To toggle the drawing aids on and off, click on the 
desired button once with your left mouse button.  See chapter 7, "Drawing with Precision," in the 
AutoCAD Users Guide for more information about AutoCAD drawing aids. 
 

Scroll Bars 
 
The scroll bars allow you to pan the drawing display.  AutoCAD scroll bars function just like those in other 
Windows applications. 
 



 16 

Preferences 
 
Most of how AutoCAD looks and behaves is controlled by configuration settings.  You can change many 
AutoCAD window and drawing environment settings in the Options dialog box. For example, you can 
change how often AutoCAD automatically saves a drawing to a temporary file, and you can link AutoCAD 
to directories containing files you use frequently. Experiment with different AutoCAD environment 
settings until you create the drawing environment that best fits your needs. 
 
To change AutoCAD options 
 
 1 From the Tools menu, choose Options. 
In the Options dialog box, choose a tab and select the settings that you want to change.  
 
The Options dialog box will display: 
 

Files Tab 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
This screen allows you to make changes to menu files, support directories, temporary file names, templates, 
etc.  To make changes, click on the “+” to expand the options you need to modify.  It may be necessary to 
expand multiple levels to reach the changes you need to make. 
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Display Tab 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
This screen allows you to make changes to how the AutoCAD screen looks.  The most used features on this 
screen would be “Window Elements” (fonts, colors, scroll bars, etc.) and “Crosshair size” (this is a 
personal preference, with 100% extending the crosshairs to the edges of the drawing area). 
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Open and Save Tab 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
This screen allows you to make changes to how drawings are handled when opened and saved.  Note that 
this is where you set the frequency of automatic drawing saves.  AutoCAD defaults to 120 minutes, but 
with the improved speed of computers, you would be better served to set this option to 15 or 30 minutes.  
This way, if the computer crashes, you only lose 15 minutes of work, not two hours. 
 
The default file extension for temporary files is .ac$.  If your experience a system crash, or AutoCAD 
freezes, you can find the temporary file (from automatic saves) in the directory specified under the “Files” 
tab.  To restore the latest version of your work before the crash, rename the .ac$ file to .dwg file. 
 
Temporary files are handy, but can be troublesome to find and use.  You are not sure what actually got 
saved, just that it was not longer than 15 minutes before the crash (or whatever you set your interval to).  A 
better alternative to relying on temporary files is to get into the habit of frequently saving your drawing.  It 
is much easier to click on the “Save” button at regular interval and not have to worry about changing file 
names.  Temporary files should be regularly removed from your hard disk, or network drive, to conserve 
space and reduce clutter. 
 
Another handy item is the .bak file.  This is a backup file created by AutoCAD each time you save the file 
you are working editing.  Again, you just need to rename the .bak file to a .dwg file to make it a valid 
drawing file.
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Plotting Tab 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
This screen allows you to set the default printer that AutoCAD will use when you plot drawings.  In 
addition to naming a default plotter, you can set the default plot style table.  Plot style tables can be edited 
in the plot dialog box, and allow you to modify various settings that affect how the drawing is plotted.  In 
this example, a custom plot style table was created (for an HP Laser printer) that prints everything in black 
(monochrome), except the color 9 (light gray on the screen).  Color 9, in this case, was modified to print as 
a gray scale, which is handy for plots with shaded areas. 
 



 20 

System Tab 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
This screen allows you to set the general AutoCAD system settings. For example, by default you can work 
with multiple documents in one session, but you can change AutoCAD to Single Document mode by 
selecting Single Drawing Compatibility Mode under General Options. 
 
After you install AutoCAD, you usually do not need to perform additional configuration tasks for the 
mouse or digitizer, because AutoCAD uses the current system pointing device. However, you can change 
the current pointing device and control whether AutoCAD accepts input from a digitizer only or from both 
a digitizer and a mouse.  Other settings that you can change on the System tab include use of long symbol 
names, startup dialog box display, behavior during user input errors, LISP file-loading behavior, OLE scale 
dialog box behavior, warning message display, database connectivity behavior, and 3D graphics display 
properties. 
 



 21 

User Preferences Tab 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
This screen allows you to set up your drawing environment according to the way you work best. You can 
customize settings for shortcut menus and set display properties for hyperlinks in your drawing.  
Other settings that you can change on the User Preferences tab include Windows standard behavior, 
AutoCAD Design Center preferences, object sorting methods, priority for coordinate data entry, lineweight 
settings, and hyperlink preferences. 
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Drafting Tab 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
This screen allows you to control settings of several AutoCAD drawing aids. For example, AutoSnap helps 
you locate exact points on an object. AutoTrack helps you draw objects at specific angles or with specific 
relationships to other objects in the drawing.  You can also set the color and size of the AutoSnap marker 
(the box that shows up when you snap to endpoint of a line, for example) and the size of the aperture box 
(the box displayed at the intersection of the crosshairs). 
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Selection Tab 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
This screen allows you to control the AutoCAD selection tools and object selection methods. You can 
control the size of the AutoCAD pickbox and specify selection modes that you want turned on while you 
draw. For example, the Implied Windowing option creates a selection window when you click in the 
drawing area. If you select Use Shift to Add to Selection, you can expand an object selection set by holding 
down SHIFT while you select the new objects.  Other settings that you can change on the Selection tab 
include grip behavior and properties, press and drag selection, noun/verb selection, object grouping 
selection, and associative hatch selection. 
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Profiles Tab 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
This screen allows you to create and save your drawing environment settings as a profile. If you share your 
workstation with other users who use the same login name, you can restore your options by making the 
profile current. You can also create and save profiles to use with different projects. By default, AutoCAD 
stores your current options in a profile named UNNAMED PROFILE. AutoCAD displays the current 
profile name, as well as the current drawing name, in the Options dialog box. 
 
The profile information is stored in the system registry and can be saved to a text file (an ARG file). 
AutoCAD organizes essential data and maintains changes in the registry as necessary. 
Once you save a profile, you can export or import the ARG file to and from different computers. If you 
make changes to your current profile during an AutoCAD session and you want to save those changes in 
the ARG file, you must export the profile. When you export the profile with the current profile name, 
AutoCAD updates the ARG file with the new settings. You can import the profile again into AutoCAD to 
update your profile settings.  

To make a profile current 
From the Tools menu, choose Options. 
In the Options dialog box, choose the Profiles tab. 
On the Profiles tab, select the profile you want to make current. 
Choose Set Current. Then choose OK. 
  
 Command line  OPTIONS 
 Shortcut menu  With no commands active and no objects selected, right-click in the drawing area 
and choose Options. 
 You can also initiate a specific profile before starting AutoCAD by using a command line switch.  
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To make a profile current before starting AutoCAD 
  
On the Windows desktop, right-click the AutoCAD icon to display the shortcut menu. 
Choose Properties from the shortcut menu. 
In the AutoCAD Properties dialog box, choose the Shortcut tab. 
Under Target, enter /p currentprofile after the current target directory. For example, to make the profile 
User12 current, enter the following in Target: 
 
 "c:\acad2000\acad.exe"/p user12  
 
 Choose OK to exit the dialog box.  
 
 The profile name you enter is the current profile each time you start AutoCAD. 
 
When you have made all of the changes you require, click “Apply” to see the changes take effect, then 
click “OK”. 
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LAYER MANAGEMENT 
 
Layers are like transparent overlays on which you organize and group different kinds of drawing 
information. The objects you create have common properties including colors, linetypes, and lineweights. 
An object can assume these properties from the layer it is drawn on, or properties can be specifically 
assigned to individual objects. Color helps you distinguish similar elements in your drawings, while 
linetypes help you differentiate easily between different drafting elements, such as centerlines or hidden 
lines. Lineweights represent the size or type of an object through width, enhancing your drawing and 
increasing legibility. Organizing layers and the objects on layers makes it easier to manage the information 
in your drawings. 
 
Layer management is especially important when standardizing drawing files created in your office.  
Standardizing layer names (and their associate colors and linetypes) makes it much easier for others in your 
office to easily understand what they are seeing. 
 
You always draw on a layer. It may be the default layer or a layer you create. Each layer has an associated 
color, linetype, lineweight, and plot style. You can use layers to organize drawings into groups of objects as 
well as to identify different objects with varying colors, linetypes, and lineweights. 
 
For example, you can create a layer for centerlines. You assign the properties you want for centerlines 
(color, linetype, lineweight) to the layer. When you want to draw a centerline, you switch to the centerline 
layer and begin drawing. You do not need to specify a linetype, lineweight, and color every time you draw 
a centerline.  
 
You can also assign a plot style to a layer.  Plot styles control how your drawings are plotted.  For example, 
you can plot a drawing with all the centerlines at a 50 percent value (or "screened") by assigning a plot 
style to that layer. Using layers is a major advantage of creating drawings with AutoCAD® instead of with 
paper and pencil. 
 
To access Layer Properties Manager 
 
1 From the Format menu, choose Layer. 
  
The Layer Properties Manager allows you to manage all aspects of your layers.  You can: 
 
Create or delete layers 
Assign colors to individual layers 
Assign linetypes to individual layers 
Control layer visibility (freeze to hide, thaw to display) 
Set the current working layer 
Lock or unlock layers (Locking is useful for displaying items on a layer you don’t want to edit) 
Control layer plot styles and whether layer plots, or not 
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The Layer Properties Manager will look like the following: 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Complex drawings can remain organized by thoughtful use of layers.  Care should be taken, however, that 
you do not go overboard with layers.  Drawings with too many layers can become cumbersome to use.  
Layers that are no longer needed should be deleted to save drawing space and remove clutter. 
 
 
Nested Layers 
Ortho 
Snaps 
Coords 
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UCS BASICS 
 
As you draw you use the coordinate system to specify points in the drawing. All information entered in 
AutoCAD is located on a Cartesian coordinate system.  You can locate and use your own movable user 
coordinate system (UCS) for working on angled, isometric, or orthographic (3D) views. 
 
Rotating the UCS about the Z axis can be helpful if you have a drawing that will not fit well on a given 
page size with North aligned with one edge of the paper.  Rotating the UCS can provide for better fit and 
presentation. 
 
A Cartesian coordinate system has three axes: X, Y, and Z. When you enter coordinate values, you indicate 
a point's distance (in units) and its direction (+ or –) along the X, Y, and Z axes relative to the coordinate 
system origin (0,0,0) or relative to the previous point. Usually, when you begin a new drawing in 
AutoCAD®, you are automatically in the world coordinate system (WCS); the X axis is horizontal, the Y 
axis is vertical, and the Z axis is perpendicular to the XY plane.  In simple terms, the display you see when 
working in the WCS is a plan, or “bird’s eye” view of the drawing. 
 
In addition to the WCS, you can define a movable user coordinate system (UCS) with a different origin and 
axes in different directions. You define a UCS in terms of the WCS.  You can use a template with a UCS to 
start a drawing that does not use the WCS.  Be sure that you fully understand how a UCS differs from the 
WCS.  When inserting a block or drawing into your current drawing, they may not be placed in the desired 
location if the coordinate systems do not match. 
 
Polar coordinate systems use a distance and an angle to locate a point. When you enter polar coordinate 
values, you indicate a point's distance from the origin or from the previous point and its angle along the XY 
plane of the current coordinate system. 
 
To indicate the location and orientation of the UCS, AutoCAD displays the UCS icon either at the UCS 
origin point or in the lower-left corner of the current viewport. If the icon is displayed at the origin of the 
current UCS, a cross (+) appears in the icon. If the icon is displayed in the lower-left corner of the 
viewport, no cross appears in the icon. 
 
If you have multiple viewports, each viewport displays its own UCS icon. 
 
AutoCAD displays the UCS icon in various ways to help you visualize the orientation of the drawing plane. 
The following figure shows some of the possible icon displays.  
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The broken pencil icon replaces the UCS icon when the viewing direction is along a plane intersecting the 
X and Y axis. Specifying coordinates with the pointing device while the broken pencil icon is displayed 
produces points with nonzero Z values. Results may not be what you expect. Make sure that the UCS icon 
display indicates that the viewing direction is at an angle that allows sufficient pointing device accuracy 
before attempting to specify coordinates or edit your model. 
 
 
 

To turn the display of the UCS icon on and off 
 
1 From the View menu, choose Display !UCS ! Icon.  
2 To turn the display of the UCS Icon on or off, select On.  
 
A check mark beside the On option indicates that the icon is displayed. Choose On again to remove the 
check mark and turn the UCS icon off. 
 

To display the UCS icon at the UCS origin 
 
From the View menu, choose Display! UCS ! Icon !  Origin. 
 
A check mark beside the Origin option indicates that the icon is displayed. The UCS icon is displayed at 
the origin of the current coordinate system. Choose Origin again to remove the check mark and display the 
icon at the default position in the lower-left corner of the current viewport. 
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